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County District Elections- 
Has the Time Come? 

The Kaua`i County Charter Review Commission, 
chaired by Barbara Robeson and co-chaired by Louis 
Abrams, asked the League to research the pros and 
cons of district elections and reapportionment. The 
topic will be on the agenda again November 23, and 
League members are encouraged to attend to hear 
updates on recommendations. Below is the substance 
of a presentation made by Carol Bain Oct. 26. 

TITLE:   Research /Overview: Election of 
Single Council Districts V At Large  
& related Reapportionment Issues 

 
Basic Differences include: 

 election at large– tends to centralize power 
(especially in a county where voter turnout 
may be low)  

 election by district – spreads power to that 
district  

 
HISTORY: 9 charter amendments on the 1996 Ballot for 
Kauai voters.   

Proposal 1 – Effective 1998 shall Council 
members be selected by districts, with one 
member residing in and elected from each of 
five districts, which shall be established by an 
apportionment commission to be appointed in 
1997, and two members elected at-large, and 
shall 2001 and every tenth year thereafter be a 
reapportionment year? 
 

This charter amendment, as worded, failed in 1996. 
                 44%  No ;  38.8% Yes;  (Blank 17.1) 
Actual votes:# 9589                8456         3729 
 
QUESTION – Should voters be presented with the 
option of district  elections for Council members in 
2006?   To decide, we must first consider the pros 
and cons of the issue. 

  

Open Records – Key to 
KIUC Accountability 

Watchdog Effort Continues 
No one has to remind League members and 
others who support open government that open 
records laws, known as the Uniform Information 
Practices Act, allows citizens access to 
information needed to make decisions. Our 
electric cooperative does not have to be a 
government agency to follow sunshine laws, and 
should be encouraged to adopt and comply with 
open records laws. 

The situation will not get better unless KIUC 
members, and that means League members too, 
start speaking out, writing to KIUC & media, 
attending their public meetings, and pushing for 
good government compliance.  Call League 
president, Carol Bain, 246-2111. 

Attend KIUC Board Meetings:  
November 29, 2005 
December 13, 2005 

At their Kukui Grove office.  
4463 Pahe`e Street, Lihue, 241-4300 

http://www.kiuc.coop/publictestimony.PDF 

LET THE  

SUNSHINE IN 

 

 

continued on page 2
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Review and analyze the cons or reasons for No Votes and 
pros/reasons for Yes Votes to decide: 
 
Wording on 1996 ballot (in italics) for what a “No Vote” 
means: 

#1. Kauai is small enough in area and number to retain 
all at large representation. 

U.S. Census 2004 data shows almost 62,000 people on Kauai. 
This represents a 5.9% growth from 2000. The growth of 
Kauai population is significant. According to Planning 
Department’s Economic and Population Projections & 
County General Plan,  Kauai is projected to have a resident 
population of between 65,300 and 82,800 in 2020.  If this 
growth is a considered a factor, the district apportionment 
must first be planned for carefully. One idea is to use the 3 
current districts apportioned for state representative elections. 

#2.  Districting promotes provincialism and consequent 
pork barrel and log rolling politics 
Research has indicated that local government spending does 
rise because district representatives feel they must bring 
capital/other improvements to their voters for their district.  
Fights over limited resources result. A partiality for one’s 
district may occur. There are examples of governments that 
have districting without the pork barrel/log rolling problems.  
The County of Hawaii charter has the advantages of being 
both nonpartisan (as Kauai is) and has term limits for council: 
these hinder the bad practices described.  
 

 #3.  Centers election to district candidates and lessons 
county wide concerns 

Without districting, it is true government tends to be 
centralized. Rural areas generally have fewer public 
resources. Majority of public resources are located in Lihue.  
Our county parks show the number of acres to be fairly even 
in all districts, though the cost analysis may show outlying 
parks receive fewer improvements and maintenance dollars. 

 
 Wording on the 1996 Ballot (in italics)  for reasons for 
what a  “YES Vote” means:  

1. Designates a council member to go to for help and 
to hold responsible for district problems  

However – what if person elected is not voter's 
preference? 
2. Encourages resident candidates, popular among 

neighbors who know him/her best, to run for office  
Research shows challengers have better chance in district 
elections. It is argued that districts better represent 
minorities, both ethnic & preference.  However, 
minorities may be spread over more than one district and 
not have enough votes in one district to win a seat. 
3. Reduces cost of campaigning by reducing 

representative area and number of voters affected in 
campaigning  

Studies show campaign costs often lower than those 
running at large because area to cover is geographically 
smaller.  Money is often a major factor in getting name 
recognition, hence votes. 
 

Two Amendment Options are presented:   
Charter Amendment: Option #1  
QUESTION – Should voters be presented with the option 
of districts elections for Council members in 2006? 
Suggestion: Combine best of both options using 3 districts. 
 Possible wording of a charter amendment on the 2006 
Ballot for Kauai voters: 
Proposal  – Effective 2008 shall Council members be 
selected by districts, with one member residing in and 
elected from each of three districts, which shall be 
established by an apportionment commission to be 
appointed in 2007, and four members elected at-large, 
and shall 2011 and every tenth year thereafter be a 
reapportionment year?  
The map below shows the 3 state district boundaries 
suggested to be used for Kauai county district elections. 
Note: Ni`ihau is part of  District #16. 

 
Charter Amendment: Option #2  
After discussion with County Elections office staff, 
another option may be considered that could combine the 
best aspects of at-large representation and also define a 
minority district representation. 
QUESTION – Should voters be presented with the option 
of districts elections for Council members in 2006? 
Suggestion: Combine best of both options using 3 districts 
yet keep “at-large” voting for all. 
 Possible wording of a charter amendment on the 2006 
Ballot for Kauai voters: 
Proposal – Effective 2008 shall seven Council members 
be elected at large, with four members having no 
residency restrictions, and three members elected who 
reside in one of each of three districts consistent with 
state district reapportionment procedures, and shall 2011 
and every tenth year thereafter be a reapportionment 
year?  
 
NOTE: This proposal and pros & cons review is on 
the Charter Commission meeting agenda, Wed., Nov. 
23, 4:30 pm, Rooms A&B Mohikeha Building, Lihue 
CC. Please bring this newsletter with you and speak; 
share your manao / thoughts. 

continued from page 1 
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Kaua`i League Joins  
State-wide Coalition for 

Good Government  
Statement on Kaua`i Court Ruling 
Allowing Agencies to Challenge 
Office of Information Practices 

Open government and journalists group leaders 
issued a public statement today in response to a 
recent court ruling on the open records law. The 
leaders and their organizations include: Right To 
Committee, League of Women Voters of 
Hawai’i, League of Women Voters of Kaua’i 
County, Society of Professional Journalists 
Hawai’i Chapter, Big Island Press Club, Citizen 
Voice, Hawai’i Pro-Democracy Initiative, and 
Honolulu Community-Media Council.  

The statement of these groups follows:  

Before 1989, people had to sue their government 
to force it to release a record that should be 
public. Fortunately, that year the Legislature 
amended the Hawai’i open records law to allow 
the public to appeal a records denial to a state 
agency – the Office of Information Practices.  

If OIP upheld a denial, the requestor could still 
appeal to circuit court. But, as HRS section 92F-
15.5(b) states, if OIP’s “decision is to disclose, 
the Office of Information Practices shall notify 
the person and the agency, and the agency shall 
make the record available.”  

Sounds straightforward and clear. But a senior 
judge on Kaua’i thinks otherwise.  

Earlier this year, the Kaua’i County Council 
refused to release executive session minutes 
requested by Kaua’I residents and a journalist. 
On appeal, OIP reviewed the minutes and ruled 
that the records must be made public.  

Instead of providing the minutes, the Council 
challenged the ruling by filing a lawsuit in June. 
Although the Council’s right to file the lawsuit 
was questioned, two months later Kaua’i Judge 

George Masuoka ruled that an agency is 
allowed to appeal an OIP ruling to a court.  

We must respectfully disagree, because the 
legislative intent of the law could not have 
been clearer. Three legislative committees 
reviewed the bill and stated their intent in 
committee reports, all of which contained the 
following identical language.  

“Your Committee wishes to emphasize that 
while a person has a right to bring a civil 
action to circuit court to appeal a denial of 
access to a government record, a government 
agency dissatisfied with an administrative 
ruling by the OIP does not have the right to 
bring an action in circuit court to contest the 
OIP ruling.”  

We believe the open records law and the 
intent of its drafters has been misunderstood. 
We hope an appeal to the highest court isn’t 
necessary to fulfill the policy intent of 
Hawai’i’s open records law. Documents on 
this issue are online at www.newhawaii.org.  

 
(UPDATE: Case is on its way to State 

Supreme Court for appeal.  Good to know  
many groups & journalists are supporting 

sunshine & open records laws.) 
 

ANNOUNCEMENTS: 
 

 LWV Kaua`i board meets at the  
YWCA gazebo in Lihue 

 Monday, Nov. 14, 2005 & Jan. 14, 2006 
 Call 822-5918 to join LWV Kauai 

Transportation Committee 
 Kauaians for Open Access  information– 

email: bain@kauai.net or call 246-2111 
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M O R E  W A Y S  T O  C U S T O M I Z E  
T H I S  T E M P L A T E  

FOOTERS 

To change the text at the very bottom of each page of your 
newsletter, click Headers and Footers on the View menu. 
Use the Header and Footer toolbar to open the footer, and 
replace the sample text with your own text. 

INSERT SYMBOL 

It is a good idea to place a small symbol at the end of each 
article to let the reader know that the article is finished and 
will not continue onto another page. Position your cursor at 
the end of the article, click Symbol on the Insert menu, 
choose the symbol you want, and then click Insert. 

CONTINUED TEXT 

To let the reader know that an article will continue on 
another page, insert a small text box under the text box, 
choose the Continued To style, and then type the words 
“Continued on Page”. 

Inserting and Editing 
Pictures 
Type your sub-heading here 

You can replace the pictures in this template with your 
company’s art. Select the picture you want to replace, point 
to Picture in the Insert menu, and click From File. Choose a 
new picture and then click Insert. Select the Link to File box 
if you don’t want to embed the art in the newsletter. This is a 
good idea if you need to minimize your file size; embedding 
a picture adds significantly to the size of the file. 

To edit a picture, click on it to activate the Picture toolbar. 
You can use this toolbar to adjust brightness and contrast,  

Choose a new picture, and click the Link to File 
box if you don’t want to save the art with the 

newsletter. 

change line properties and crop the image. For more detailed 
editing, double-click on the graphic to activate the drawing 
layer where you can group or ungroup, re-color, or delete 
picture objects.  
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